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Embedding Power Bl Dashboard in Website!
-I-ECI'II ETALKS Implementation

.rﬁ]"l Power Bl

Step 1 : Publish the report in Power Bl service account. Once the
Overview report is published, click on File button and select the option of

: : Publish to web.
Power Bl provides its user to

easily embed a report to their Step 2 : Copy the HTML code as required. The Size can be
website. Any report created selected to generate custom link accordingly

through Power Bl can be P T ERON =N B RO 0 PN Y
embedded. Here we have Step 3 : Paste the link in the website to display the report in
embedded a Power Bl report your website.

with NSS website.

Link:
hitp://nicesoftwaresolutions.co
m/power-bi-2

nice
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Advantages

Embedding a report to the
website can help users of the
organization to easily access the
report. The customers and users
who visit the website will be
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able to view the report. fE [ﬂ:&' »
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il Power BI

TecHieTaLKS

Overview

You can subscribe yourself and
your colleagues to the report
pages, dashboards, and
paginated reports that matter
most to you. Power Bl emails a
snapshot to your inbox. You
tell Power Bl how often you
want to receive the emails.

G IVETNET-E

You receive an email with a
snapshot of the report page or
dashboard, with a link to open
the report or dashboard. On
mobile devices with Power Bl
apps installed, selecting this
link launches the Power Bl
app, instead of opening the
report or dashboard in the
Power Bl web site.

+ Courtesy : Ashwin Kulkarni

Email subscription in Power Bl

Implementation

Step 1: Login to service account and go to any report from
the top menu bar, select Subscribe or select the envelope.

Step 2 : Use the yellow slider to turn the subscription on
and off. Enter email address also enter subject and
message.

Step 3 : Select a Frequency for your _

subscription: Daily, Hourly, Weekly, =
Monthly, or After Data Refresh (Daily).

Step 4 : User will receive email on scheduled time
with screenshot of the dashboard/report.

nice
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wl) Power Bi

TecHiETALKS

Overview

Alerts can beset byUsers, set
the rule for any measure in the
visualzation

Set the condition and threshold
for the alert to trigger, set the
notification frequency. Itwill
trigger an emailto besent to the
user setting the alert

Advantages

Alerts can be usedto notfy users
if when datainthedashboards

changesbeyond limntsthe user
has set

Set Alert and Trigger Email in Power Bl

In this example, we are aeating an alert that
notifies you once a3 day if the number of total
storesgoes above 100,

Implementation

Step 1 : Start on a dashboard and select
the ellipses.

104

Step 2 : Select the belliconto add one or
more alerts

Step 3 :Tostar, select+ Add alert rule,

ensure the Active slider issetto On, and

give your alerta title. Titles help you
easily recognize your alerts.

Step 4 : Scrolldownand enter the alert
details.

nice
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G Power Bl Use Transaction Services in Power Bl - PowerApps Integration

-rECl-Il ETA LKS Implementation

Step 1 : Import the PowerApps visual from the Microsoft
Overview store. Use the visual in the PBIX file. Select all the fields
from the table which you want to use in the app or form.

PowerApps can be used to
create Apps that can run on Step 2 : Click on create new, this will lead

Android, i0S, Windows. you to PowerApps studio portal.
PowerApps can also be used to

create feedback forms. Step 3 : The user can create forms or

It can also be used to input apps with the help of PowerApps studio.
data into database.

Advantages

6/28/2019 5:30
PowerApps forms can be

integrated with Power Bl 6/28/2019 5:30
reports to take suggestions or
feedbacks by the users. WIANRSN

6/27/2019 5:30
6/27/2019 5:30

6/27/20195:30

niee m Power Bl
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Courtesy : Noel Samuel



W Power Bl Open outlook using Power Bl

TEC"" ETALKS Implementation

Step 1 : Insert a textbox in the report to enter the Step 3 : Click on email link. And click on allow.
Overview email address. Select Textbox enter * and select
font as wingdings

Sometimes, there is a situation
when a client requests that
whenever they click on

an email link, it will
automatically open the link in
a new page. Power Bl provides
a functionality to show an
email as a hyperlink.

@) Paper Manufacturing Analysis

Step 4: it will open the selected mail browser to

Advantages | send the email. TO and from fields will be

" Wy Rarchsaon PGS P CHRONCRS AT
(i N Caen, P A ok T et

automatically filled.

» This functionality lets you
send emails directly to
clients by opening Outlook
just by one click.

User doesn’t need to
switch apps manually.
TO and FROM fields are
automatically filled.

Step 2 : Enter email address with prefix as
in URL field.

Courtesy : Ashwin Kulkarni m Power BI

Software Solutions




Ml Power Bl Infographic design visualization
TEC |'I| ETALKS Implementation

Step 1 : To create visual for drinks sold in a Step 3 : Select design from range of visuals
Overview restaurant we will use infographic design. that suits best for your story.

Import infographic visualization from market L e
Are you looking to tell a story place. shaped ¥

with your data? Or have you
ever wanted your charts and
reports to be highly tailored to
your specific topic? The new
infographic designer custom
visual for Power BI gives you
the flexibility to achieve this

and more! D
Advantages : :
g Step 2 : Select the shape of the visual. Step 4 : Change shape/design of each visual

The infographic designer according to your requirement..
custom visual lets you control g

the specific appearance of | *

lists, bar charts, and column
charts with precise control of

e 53TM
shapes, color, and layout so :"f -
that you can represent u “
information in a way that best

tells the story of your data. .
nice

Courtesy : Ashwin Kulkarni Software Solutions m Power Bl
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) Power Bl

TecHIETALKS

Overview

You can create visually rich
report tooltips that appear
when you hover over visuals,
based on report pages you
create in Power Bl Desktop.
While creating such tooltip, it
can include visuals, images,
and any collection of items
you create in the report page.

Advantages

You can create as many tooltip
pages as you want. Each
tooltip page can be associated
with one or more fields in your
report. The tooltip you created
on your tooltip page appears
when you hover over the
visual.

Courtesy : Ashwin Kulkarni

Use Report page as Tooltip

Implementation

Step 1 : To get started, create a new report page by Step 3 : Turn on tooltip slider inside Page
clicking the + button and In the Format pane of the Page information in format pane of tooltip visual.
Size card, select page size template as Tooltip.

VESUALIZATIONS

Step 4 : Create visual which need to be shown
as tooltip and select tooltip page in tooltip
fields of parent visual.

il

Qﬂ!%utions . - m Power Bl



Wl Power Bl Customized tornado visual using table visualization
TEC |'I| ETALKS Implementation

Step 1 : To get started, select Grid visual and select Step 3 : Go to column headers and make outline
Overview values that you want to show in Tornado Chart. as None also make font color as background color.

Than go to conditional formatting and make data

These are special type of Bar R _ s
charts, where the data Visualizations ’ g e bars on by entering all other fields.

categories are listed vertically | sl e
instead of the standard £ o R
horizontal presentation, and

the categories are ordered so
that the largest bar appears at
the top of the chart and so on. &

Font color

d Step 2 : Select Style type as NONE and turn off both
AUEII‘ItElgES— Vertical and Horizontal grids also make Row padding
It shows the effect on the as 10.

output of varying each input

variable at a time, keeping all ; B ]
the other input variables at Step 4 : Centrally align the data of all fields under
their initial (nominal) values. N = field formatting and apply required color.
Creating Tornado Chart using N Subject! IR
table /grid visual will allow SRS R p——
you to put data labels between TR ;

two values. R . _ :

T EEEEN Subiect:

nlee B Suoiects IR m PDWEF BI

Courtesy : Ashwin Kulkarni S o .




m Power BI
TecHiETALKS

Overview

You can run Python
scripts directly in Power
Bl Desktop and import
the resulting datasets
into a Power Bl Desktop
data model.

Advantages

Enables you to use Python
scripts to prepare your
dataset, apply sophisticated
analytics or machine learning
in the Power Bl Desktop and
then plot the results in your
Power Bl reports using any of
the hundreds of open-source
Python visualization packages.

Courtesy : Noel Samuel

Importing CSV file in Power Bl using Python Script Editor

Implementation

To run your Python Script in Power Bl
Desktop:

Step 1: In the Home ribbon, select Get Data >
Other > Python script as shown in the image.

Step 2: Select Connect. Your local machine’s
latest installed Python version is selected as
your Python engine. Copy your script into the
Python script dialog box that appears. Here,

we enter the simple Python script shown in
the second image.

Step 3: Select OK. If the script runs
successfully, the Navigatordialog boxappears
and you can load the data and use it. Data
can be loaded or edited before using it any
further.

nice

Software Solutions

Other

data = pandas.read_cC

rupy. 7 p—— e e AT
sv( 'D..'Dcr.e} BI/EuStockMarkets_NA")

m Power BI




Wi Power Bl Importing data from a PDF file in Power Bl Desktop
TEC I'II ETALKS Implementation

Step 1: Launch the Power Bl and go
to the File menu. In the File menu, go

In Power Bl Desktop, you to Optionsand

can connect to a PDF settings>0Options>Preview

file and use the included features>Get data from PDF files.
data from the file, just like

any other data source in Step 2: Once we relaunch Power

Power BI Desktop. Bl Desktop, go to Get Data->More
again from the menu bar. In the
following screenshot, you can get
a new option under ‘File’. We get

In this way, one can easily the option ‘PDF (Beta) to use as a
source data from PDF files data source.
without any coding. Another

option to source data from Step 3: Click on PDF (Beta)
PDF files is by using R Scripts, connector and connect. PDF file can

but:that would require be loaded in Power Bl to create
installation of some external meaningful reports.

packages on an R server as
well as few lines of code.

Overview

Advantages

Software Solutions

Courtesy : Noel Samuel n I C E m Power Bl



o) Pawer Bl Add expand/collapse feature to column headers
TEC |-I| ETALKS Implementation

o i Step 1. Use the matrix visualization and Region Level-2| Level-3 Le~.-'el-4i Total
verview . = ;
ke | sclect the rows and columns as required. || kpap 2171 117| 4888

- . . Australia : 195 442
Grouping rows or columns in China 26 858 26| 1482
12

Power Bl can be very useful Step 2. Under the formatting pane Germany 13
if you want to visually group toggle the “+/-” button. Guam | | | B
items under a heading, or if _ Hong Kong = i | =
you want to be able to hide 2= — g 1 - =i ffﬁ

or show data for better Total 468| 26468
display.

Region Level-1 | Level-2 Level-4| Total

o - KDNA 10725
Adua ntages United States 3965 34 5489 156| 9984
e Canada 299 | 26| 16 | | T4
Once you group Power Bl KDLA 1040

group columns with headers, Step 3. The datain the matrix will be ey - | 9802

Uzbekistan 13 39

you can more easily manage displayed with + and — sign. When a United States 26

the data. Your headers could user will click + the data will expand H United Kingdom | 1287

T ) ) ) Ukraine 65 | | . 65

he-the tolals Tor each area’on and clicking on — will collapse the Turkey z ZEIET)

that budget, with your Thailand 13 13

. _ data. e -
collapsible columns being the i i |

. g Cyvaamel o Fh | 6
line items for each area. Total

nice

Courtesy : Noel Samuel ot i m Power Bl




) Power Bl

TecHIETALKS

Overview

hierarchy slicer is created
with single fields or pre-
defined - as a slicer to filter
other report items. Each
level can be expand or
collapsed for optimal
navigation thru the hierarchy
and to find to the correct
attribute from the slicer.
Advantages

Lets you expand and dig into
each level of your hierarchy
data.

Allows you to display a
measure value at the lowest
level.

Replaces the idea using
multiple regular slicers to
represent what the Hierarchy
Slicer does.
Courtesy : Noel Samuel

Hierarchy slicer

Implementation

Step 1 : To start with import Hierarchy slicer
visual from market place. Select hierarchy slicer
from visualization pane.

Visualizations

Step 2 : Go to Format pain and select Selection
pane where you can choose to turn on the
ability for multi-select values in the Hierarchy

~ Selection
SirgES— On —.

Revert to default

nice

Software Solutions

Step 3 : Go to Header section to change the slicer
Title and adjust other formatting settings of the title.
Go to Items section to adjust the formatting of the
hierarchy values.

Background
TextSze |16 —O——
_Revert to default Revert to default

Step 4 : Final output

i . N S e AT AR L R e
Froduct Lateqories

.rm Power BI




m Power BI
TecHieTALKS

Overview

Creating a dynamic slicer to
show different measures in a
chart using disconnected
tables making it more
dynamic and flexible for
users consuming the reports.

Adva ntages

The advantage of using this
technique makes the
visualizations more dynamic
and flexible for the users
consuming the reports.

Dynamic measure selection for slicer value— Power BI

Implementation

Step 1 : Create a disconnected table. The
disconnected table stores my values that | want
to display on my slicer.

Step 2 : Creating a dynamic measure using DAX
function as SWITCH and SELECTEDVALUE

Step 3 : Place the slicer and drag the measure
created in the disconnected table. Similarly,
Drag the created dynamic measure to the visual
so that values gets changed according to the
selected value in the slicer.

HUBESN

REERE ;

)
Courtesy : Nitesh Trehan Qv!,ecsm Uems m Power Bl




mj) Power Bl

TecHieTALKS

Overview

Creating dynamic customized
titles in Power Bl Visuals. Need
to create a DAX expression
based on which we will be able
to create the dynamic title.

Advantages

Dynamic titles are powerful
and immensely valuable from
a user- experience stand
point.

Courtesy : Nitesh Trehan

Dynamic visual titles using title expression— Power B/

Implementation

Step 1 : Creating an expression-based title to

create a field in your model to use for the title.

Step 2 : Once the DAX is created in the step 1,
you need to apply the same on the visual title.
To select the field and apply it, go to the
visualizations pane. In the format area, select
the title. When you right right-click on the title
text, a context menu will appear that allows you
to select the conditional formatting. After that
the title text dialog box will appear.

nice

Software Solutions

Ml Power B




M) Power Bl Use unichar characters in calculated column and measure-
TecHIETALKS | Power B!

Overview

DAX Unichar function accepts
the integer that maps to the
character you would like to
display on the visual. It helps to

Hotel's Rating
identify what you want to -
communicate with the visuals. Step 2 : Create a measure to display the stars Hotel Stars Rating

for the hotel on the basis of score. Ashoka *hk Ak A

Step 3 : Drag the measures on the grid visual Delhi Darbaar kkx kx4 A

and then you will be able to get the things in Hyatt *ohhhhk A

Advanta_gg 2 the £ Kingsway * ok ki >

It helps to include non text Hotel Le Meridian KA kxkik A

characters inside the visuals. Marco Polo Ak A

It can also be used in the Musketeers Jhhh& | A

conditionally formatting and
Omega ok ek A

also allows to use both color
with numbers and icon to Rajdoot .2 2-2-a-d 4
Reds AT Y

indicate the direction.
Total R e T

Implementation

Step 1 : In the data view, create a calculate Unichar characters in calculated column and measures
column using the Unichar () DAX function. The
general pattern for using UNICHAR characters in
a visual is decided what you want to showcase
so that the concept is communicate well.

Y r Y L) r>»)

nice

Courtesy : Nitesh Trehan i 1?]_] Power BI




M) Power Bl Use unichar characters in calculated column and measure-
TecHIETALKS | Power B!

Overview

DAX Unichar function accepts
the integer that maps to the
character you would like to
display on the visual. It helps to

Hotel's Rating
identify what you want to -
communicate with the visuals. Step 2 : Create a measure to display the stars Hotel Stars Rating

for the hotel on the basis of score. Ashoka *hk Ak A

Step 3 : Drag the measures on the grid visual Delhi Darbaar kkx kx4 A

and then you will be able to get the things in Hyatt *ohhhhk A

Advanta_gg 2 the £ Kingsway * ok ki >

It helps to include non text Hotel Le Meridian KA kxkik A

characters inside the visuals. Marco Polo Ak A

It can also be used in the Musketeers Jhhh& | A

conditionally formatting and
Omega ok ek A

also allows to use both color
with numbers and icon to Rajdoot .2 2-2-a-d 4
Reds AT Y

indicate the direction.
Total R e T

Implementation

Step 1 : In the data view, create a calculate Unichar characters in calculated column and measures
column using the Unichar () DAX function. The
general pattern for using UNICHAR characters in
a visual is decided what you want to showcase
so that the concept is communicate well.

Y r Y L) r>»)

nice

Courtesy : Nitesh Trehan i 1?]_] Power BI




mj) Power Bl

TecHiIETALKS

Overview

Power Bl gateway acts as a
gatekeeper for the on-premises
data source. All the connection
requests are attended by the
gateway and access is granted
based on their authentication
and requirements.

Adva ntages

Gateways helps us to configure a
schedule refresh to ensure that
power Bl dataset has recent
data. It also reviews the refresh
history to analyze the outcomes
of past refresh cycles.

Courtesy : Nitesh Trehan

On-premises data fresh using gateway

Implementation

With the on-premises gateways, we can keep
the data fresh by connecting on-premises data
sources. There are two types of gateways:
Standard mode and Personal mode. Schedule
refresh is only applicable on import data and
can do 8 refreshes per day on shared and up to
48 refreshes per day on premium capacity.

Step 1 : Go to Power Bl workspace and click on the
download arrow and install the gateway.

Step 2: Click on Add Data Source, and then it will
popup various sources, select your data source
and provide the respective authentication.

Step 3: To setup the connection, open the Power
Bl service and go to settings and click on settings.
Step 4: Click on datasets tab and select the dataset
and then click on gateway connection, select the
Use a data gateway and click on Apply.

Step 5: If you want to schedule the data refresh
then click on the option and schedule the refresh
on the desired time you want to get it schedule.

nice

Software Solutions

Scid another time

m Power BI



Wil Power BI Group Visuals — Power BI Release

tech|e talks S

Step 1 : Select two or more visuals. Right Click Step 2 : Select the newly created
Overview and select “Group”. group from Selection Pane.

With Group Py
functionality in Power BI - '
Desktop, you can group visuals

together in your report, such

as buttons, textboxes, shapes

images, and any visual you

create, just like you group

items in PowerPoint.

Selection *

Advantages

Grouping visuals in a report
lets you treat the group like a
single object, making moving,
resizing, and working with
layers in your report easier,
faster, and more intuitive.

Step 3 : Change the background color
of visuals as required.

Step 4 : Change the visual size as
required.

Courtesy : Rutuja Mowade nIC E hm Power BI

Software Solutions




W) Power Bl Use Image as Slicer — Power Bl functionality

te Ch I ! t i l.ks Slicer Requirement

Overview

Slicers are a great choice when
we want to filter out data as
per the requirement on the Implementation
report canvas. Step 1 : Create a new table for assigning the available Step 2 : Select the Image column,
selector values to the required image url. change the Data Category from
“Uncategorized” to “Image URL"

Review Status  ~

Data Category: Image LIRL =

Default Summarization: Don't summarize *

Advantages

Properties

Slicers can be further tweaked
by assigning the required Step 3 : Create a slicer using new dimension “Image” as its field object.
elements to the available
values.

Assigned values can be either
Image, URL, or any other
required element list.

Visualizations

Courtesy : Rutuja Mowade nIC E 2 .. m Power BI

Software Solutions




ml) Power Bl
techie talks

Overview

The calendar table is a very
powerful technique that
can save us a lot of time.
Also referred to as Date
Dimension Table

Advantages

* (Calendar tables are
used to create
relationships between
data tables.

Acts as a lookup table
for date groupings.

Courtesy : Rutuja Mowade

Creating a DAX Calendar — Power Bl functionality

Requirement

Implementation

Step 1 : Create a Date table with the range
of required dates using a CALENDAR

function.

Eg : Date table = CALENDAR (DATE (2015, 1,

1), DATE (2030, 12, 31))

nice

Software Solutions

Step 2 : We can create various other required
columns like

Day = FORMAT('Date table'[Date],"DDDD")
Day Of Month = DAY('Date table'[Date])

Day of Week = WEEKDAY([Date],2)

Month = FORMAT([Date], "MMM") & "-" &
[Year]

Month Of Year = MONTH('Date table'[Date])
Quarter of Year = ROUNDUP(MONTH(‘Date
table'[Date])/3,0)

Year = YEAR('Date table'[Date])

Week End = [Date] + (7- [Day of Week])

il Power B




W) Power Bl Create custom card using table visual
TEC |'I| ETALKS Implementation

Overview Step 1 : To get started, select Grid visual and select Step 3 : Go to column headers and make outline
Sometimes a single number is values that you want to show in Tornado Chart. as None also make font color as background

the most important thing you Vicualizatione ) B et color. Than go to conditional formatting and
want to track in your Power BI T select the option of icons and setup conditions.

dashboard or report, such as
total sales, market share year
over year, or total

opportunities. This type of =
visualization is called a Card. i, B

=
=

Advantages Step 2 : Select Style type as NONE and turn off both
These card visuals are useful Vertical and Horizontal g]’id&.

when user have to show single
card value in comparison with
targeted value and verify
weather actual value is above
or below the targeted value.

Step 4 : Centrally align the data of all fields under
field formatting.

Final Output.

64.2%

Courtesy : Ashwin Kulkarni nIC E < . m Power Bl

Software Solutions




W) Power B Replace Dataset by changing data source
TEC"II ETALKS Implementation

Step 1 : On HOME page of Power Bl Desktop Step 3 : Select option of “Basic” and select file path
Overview click on edit queries ad select the option of  for new dataset file you want to upload. Click on OK
Data source settings. and close dialogue box.

Do want to crate a sample
report with dummy data and
then change it with actual B | pctesh | New N
data? Here is a solution how Ij;:luerie;;it — Page ~ Vi
you can do it easily. Just follow '

these simple steps to
change/replace dataset and
keeping you report intact.

Data source settings

Step 2 : Select “Data sources in current file” and Step 4 : It will automatically refresh the dataset and
click on change source button. will also change report with new data.

Advantages

Changing data source is of _
great advantage when you Prerequisite for changing dataset :

have added new data in the While changing dataset you need to have same
dataset. data/column structure as you had in earlier dataset.

When you have similar dataset
structure with different data, NOTE : There are some other methods to change the

replacing/changing dataset is dataset as well. You can change dataset using any
of great help by keeping all the method end result will always be same.

report analysis intact.
nice

Courtesy : Ashwin Kulkarni et m Power Bl




Rl Power Bl Icon sets for table and matrix
TEC |'I| ETALKS Implementation

Step 1 : select table or matrix visual and turn on  Step 3 : In addition to adjusting current rules, you
Overview icons for your table or matrix using conditional can add new rules to the list using the New rule
D | formatting feature. button and swap the order of the icons in all the
rules with one click using the Reverse icon order
button. Also you can change alignment of icons.

This feature will let you set up
rules for showing different sets
of icons to show in your table
and matrix, very similar to the o —— Surlgroun It Reverse icon order
Icon Sets feature in Excel. et i Left of data Top

lcon layout lcon alignment

+ New rule Left of data

lcon only Middle
Step 2 : When you turn on lcons, the default rules

Aduantages will apply a red diamond to the lower 33%, a yellow

e | triangle to the middle 33%, and a green circle to the Final Output.

upper 33%. But you can change accordingly.

i pr =
n.'l:;l".‘: \.'ll"."i:ll:l coliom

Showing icons along with the
data helps in analyzing the _
data. Percent ¥ [iNen | Australia $1,052
"QO@C 48,369 @ $247¢
Also it is useful to compare the 009000 o e o 52;??:
data just by looking at the S A T PR R s e
numbers and icon. CCEEEHEEdd d Canada $1,015
Icon colors helps in better A d a & 4 4 Erance v3,043

understanding of the data. % tr Tt : Sermany Alisa;
Great Britain £1,075

160 $2,724

Country Large Medium Smal Total

Courtesy : Ashwin Kulkarni n I C e m Power Bl

Software Solutions




Dynamic Row level Security with Power Bl Made Simple
TECI-IIETALKS Implementation

i) Power Bl

Step 1 : For this example let’s create two simple tables Step 3 : Go to manage Roles and give RLS to

Overview User details and salary details using Power query. Go to  User details table using DAX “Username()”
el | Relationship tab and verify the relationship between  to filter table on the basis of username. Save
Itis one of the most efficient way User Details(User ID) and Salary details (User ID); and publish the file on shared workspace.

to restrict data views across an
organization. Using DAX functions, ' , W
DRLS filters the dataset based on o ; : y 5 : D Al A
the Power Bl service user’s log-in ; ' ' :
credentials. This allows Power B = —

report authors to easily create - . [ 4 ] 6
filtered data for managing the | L= — [= =]
assignment of users to these roles. “ | i ' %:;"'"‘*i | 2
|

Advantages ‘ - " Step 4 : Make sure to give security to added
T ‘ : . ; _ users as viewer of the report. With this
whs,.pdynam"; mw|e\{e| 5.ec1.,jr|ty? ijep 2 ,.For this example, | will be using basic table S thod Tha idewes will cap thate i of
Static row level security is simple visualization.

to implement, however, if you have the world.

thousands of roles, then it would - r— . Final Output.

be a nightmare to maintain. For e i e .

example, if you want to create a . e e tiptiionts e cer ID Name UserName Cal
payroll Power Bl report, ina Nehs rragadiar@rnicesciware ' 5 i il S v
company with thousand users, you - - 1 Neha  nraigadkar@nicesoftwaresolutions1.onmicrasoft.com .
want every user to have his/her Total 25000

role. Dynamic row level security is

the answer for such scenarios. -
nlee .rlm Power Bl

Courtesy : Neha Rajgadkar Software Solutions




mj) Power Bl
techie talks

Overview

A report page can be used as
tooltip. We can say it as
information window as we can
show any visualization in the
tooltip.

Advantages

Customizing tooltips provides
additional context and
information for users viewing
the visual.

Custom tooltips enable you to
specify additional data points
that display as part of

the tooltip

Courtesy : Pooja Darbhe

Customized Tooltip with popup — Power Bl Functionality

Implementation

Step 1 : Add a new page in the report, go to format, Step 3 : Go to other page and select
enable tooltip available in page information, select Page the visualization where you wish to
size as Tooltip. show the customize tooltip, go to
formatting options.

. Page informat

Step 4 : Under
Tooltip select
Report page as
type and name of
the page.

Your Tooltip will be look like this.

Step 2 : Now design your page as per your requirement

Qw!gluhons | : » m Power BI
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teChi! tilkpéd Hierarchy Slicer

Problem Statement

A Retail company has different products with multiple branches in multiple countries. Requirement is to build a graph to compare revenue by having different
countries and Continent within one filter as a hierarchy.

| Revenue by different countries and continent

1) Multi select is possible directly in Power Bl as we have a ready made selector whereas for MSTR we need to press

- control key every time while selection.
n I G—e 2) 2)Power Bl allows the selection of multiple levels in same hierarchy, (example : Americas total as well as Mexico

bars together) while MSTR allows selection of one level at a time.

STOWETCERSTN{oIs Ml #PowerBI, #techietalks, #mstr, #MicroStrategy Courtesy- Neha Rajgadkar, Pooja Darbhe




techie talks

Problem Statement

Information Window

A retail company having different products in different line with multiple branches in multiple countries wants to build a report to compare revenue and
revenue forecast with their actual value in grid as its information window.

m Power B

- Using Bookmark, Button to create
Pop'- up wiMOW;

Bookmarks

Revenue page

In Dashboard user can achieve this
with the help of information

apply a work around for messages

-‘when we hmr ona bar chart ; ‘

|

@ Hover to view ToolTip

using any image icon as shown in
Dossier but not for showing visuals.

window, but not in dossier. You can

5 the tooltip in which you can give soms mors

Bookings by Year afmy-———rt——+
ne - Country

Q7

Total

AA A A A A AN A A A
!

T 5.56.658.82

Bookings _Forecast

e 3

I

Y

tralia R 2.75.341.12 T 3.24.902

T 6.56.857.40

B

11 $290,259,425.70
Q2'1S $292,105,839.79
QL3I'1LS S289,120,782.86
Q4'15S $293,076,463.74

»1 5 =01 rON7T 2O 13
'

In Power Bl, infowindow is directly achieved in 2 ways i.e. usingbookmarks and selection pane to create pop up window and
otheris by showingpage as a tooltip whilein MSTR thisachievablein Document directlybut not in Dossier. Idea of havingitin
Dossier has been already raised: https://community.microstrategy.com/s/idea/087440000008rfCAAQ /detail

nice

SloLVE =R e Iii(e s 0l #PowerBI, #techietalks, #mstr, #MicroStrategy Courtesy- Neha Rajgadkar, Pooja Darbhe




teChi! tilkpéd Dynamic X axis via slicer

Problem Statement

Our client wants to view the bookings of their products by continent and category on one go. So instead of building two visuals for different attributes we came
up with solution of building dynamic X-Axis line chart.

il) Power Bl

‘Duplicate the table in which
attributes are listed. Unpivot the
attributes column. By using the
attributes columnin slicer,
customer will be able to switch axis
_dynamically.

In MicroStrategy 2020 this
functionality is directly available, but
in earlier version there is workaround
to achieve it with custom dataset and
derived attribute/derived metric.

Attribute I Category © Continent I

B (ategory

In Power Bl, dynamic switch is possible by having all attributesin one column or using DAX or by making duplicate tablewitha
bi-directional crossfilter betweenoriginaltableand duplicate table. In case of MicroStrategy 2020 this functionalityis available

®
I I I‘ ‘—e directly, both in RSD as well as Dossier! Prior MSTR versions have custom data workaround.
Software Solutions #PowerBl, #techietalks, #msir, #MicroStrategy Courtesy- Neha Rajgadkar, Pooja Darbhe




teChi! tilkpéd Dynamic X axis via slicer

Problem Statement

Our client wants to view the bookings of their products by continent and category on one go. So instead of building two visuals for different attributes we came
up with solution of building dynamic X-Axis line chart.

il) Power Bl

‘Duplicate the table in which
attributes are listed. Unpivot the
attributes column. By using the
attributes columnin slicer,
customer will be able to switch axis
_dynamically.

In MicroStrategy 2020 this
functionality is directly available, but
in earlier version there is workaround
to achieve it with custom dataset and
derived attribute/derived metric.

Attribute I Category © Continent I

B (ategory

In Power Bl, dynamic switch is possible by having all attributesin one column or using DAX or by making duplicate tablewitha
bi-directional crossfilter betweenoriginaltableand duplicate table. In case of MicroStrategy 2020 this functionalityis available

®
I I I‘ ‘—e directly, both in RSD as well as Dossier! Prior MSTR versions have custom data workaround.
Software Solutions #PowerBl, #techietalks, #msir, #MicroStrategy Courtesy- Neha Rajgadkar, Pooja Darbhe




techie talks™ Column Header Colour Change

Problem Statement

Our client wants to view the expenses on customer . However they want us to bifurcate all the columns that define expenses in blue shades and Customer in
different colour. The requirement is possible by using field formatting of the grid.

m Power BI

e i In document this functionality can be
Selectnbled.reetlyfm Booicirega directly implemented whereasin

visualization. Add columns and in ey s MSTR dossier following workaround
Formatpanegotoﬁeld Formatting, e et i) e needs to be applied. Create report in
select individual column to change web, apply different colors to column
mbackgroundlionteolour sty headers, run report, from tools menu

Create Dossier and you are done.
Category Expenses_Target = i E"""’:“ Soretue E
) duct 4 B >
t 3 {5 Here 0 1
t 9 Ser H O 4 22, -~
od nar (

Ciothing Services Ritu Kumar 49,61,750.43 47.46,022.15 J 'N'-::"' chians 11841621 45434 15432300 &

t g 1 2 22
Clothing Services Roadster 49,61.750.43 47.46.022.15 Novelty 11841621.48434 | 15432300
Total 2,06,24,730.30 1,97.28,002.90 : b S Sraicis

<

In Power Bl, individual column header colour changeis directly possible with the help of field formattingin Formatpane.In
n I c._e: case of MSTR, itisdirectly possibleindocument in editable mode while thisis possiblein Dossierwithabove workaround.

Software Solutions #PowerBl, #techietalks, #msir, #MicroStrategy Courtesy- Neha Rajgadkar, Pooja Darbhe




techie talks™ Dynamic TopN Selector

Problem Statement

Our client wants to view category wise revenue generated. The requirement is to be able to see top N categories generating maximum revenue with a
selector to select TopN value. So, we came up with a DAX solution to achieve it.

Im Power BI

Create a table having values of
TopN selector to use it in slicer.
Compare rank of a category
with value selected on slicer.
Filter all records for which
category rank is less or equal
to slicer value.

1

DynamicTopN

Create Rank Metric, Insert Metric
slider, drag the newly created metric,
insert graph, drag any attribute along
with the metric on which you have
created rank, targetthe graph.

Ranktop S

16

Revenue

Show items when the value:

SO00O0nn
t OoGOL0
= 3

Is greater than v
J (4 1 4 1A
\.' t 0

. - Clothina O Yo Hook TEL" Baeotnoa Jood Houzehold and
’ >t

In Power Bl this functionality can be completelyimplemented using the mentioned DAX function with any type of filter,

®
I l I< .—e whereasin MSTR we can either usea slider or qualification for gettingthe required result.
Software Solutions #PowerBl, #techietalks, #msir, #MicroStrategy Courtesy- Nikita Dalela, Pooja Darbhe




techie talks™ Market Basket Analysis

Problem Statement

We have a retailer client who wants to compare sales of a product with another product which can help in their decision making with respect to placement
of product, determining the timing and extent of promotions on product and also have a better understanding of customer purchasing habits.

m Power B

1) Create two attnbutes Item, Order.

Create ltem metric, Create Traimng

metric, in that choose Association

as a type of analysus, then follow the

wizard steps. 2) Create a report with item, order
and training metric and run, it will
create Rule and Confidence metric

3) Create report with Item, order for all the probabilities
and all the metrics which are :

created for rule and confidence

metric.

We can implement the
concept of Market Basket
‘analysis using a single DAX
function in Power Bl

4) From the context menu of
Predicted metric, select ‘View
Predicted Model’ and choose the
view tab.

Basketanalysiscan be achievedin Power Bl by creatingasingle DAX measure and making some changesin tablerelationship,

n I C._e whereasin MSTR we have to go throughmuch long process as explained above.

SIoETGCRSTO (Vs S8l #PowerBl, #techietalks, #mstr, #MicroStrategy

Courtesy- Nikita Dalela, Pooja Darbhe




techie talks

PRICE TREND ANALYSIS USING HISTORICAL DATA

Problem Statement

Our client wants to determine possible price movement based on past patterns. The requirement is to have a table with open, close, high and low values for
a specified period of time. So, we came up with a DAX solution to achieve it.

m Power B

Create a new table from OrderDete [=] Lowvialse [~ 1) Highvalve [ =] Openvatve [~ CloseValu
modelling tab in Power Bl. sy s L

Use the SUMMARIZE 05-2018 !
function to get a new
table with open value,
close value, high value and
low value

LS IArAare [OrAarh ETITER(OrAare ArdarelAardar etatie) = "Aalsuaras")
(Orders[OrderDate], FILTER(Orders, Orders{orde 3TUS ered
alug” & C TE(MTN(Order Pavmentzsinavment aluel) rdercsiaorder rrhace *imectramnl
ue , CALLULRIT(MIN(Orger_raymentsipayment_value)j), gers er_purchase_timestamp )

LIS TTTRY % S Al L AYTE (Ardar Daimantel v & uyal T \ndanelfardars Alirsrha P tamml)
ighValue", CALCULATE(MAX(Orcder_Payments[payment_value]), Orders{order_purchase_timestamp]

/.

- el “ar ~ - o m Samnl =
rders{order_purchase_timestamp

~
o

B s =) e RSt s, A o ; 3
e E{FIRS s CiOrder Paumentclinavmant value
~ CALLULAIE(FIRSINURDLANK(UTge gyments{pay=ent_valiue

TER(Ordere Orcderelorder purchass tiwggta-a' = MAX
\ 2, U craloiuei P - S_Laflico vi

1) Go to Document or Dossier,
Import the data which you want
to use for the analysis.

3) Now create 4 different metrics

to calculate Minimum value,
maximum value, open value and
close value for that particular

~ time period.

2) Create Attribute for date,
month and year, because we
need to show the data day wise
which is our lowest level and the
selectors as Month and Year.

4) Insert Grid and drag newly
created attribute Date and other

metrics Min value, max value,
open value close value. Also add
two selectors for Year and Month.

In Power Bl, withthe help of SUMMARIZE functionin DAX we can create several valueson particulargroupina single

' ‘ I( ._e: expression, whereasin MSTR we need to create several different metrics to calculate such values.
Software Solutions #PowerBl, #techietalks, #msir, #MicroStrategy Courtesy- Nikita Dalela, Pooja Darbhe




techie talks™ Drill-Down on Time Based Data

Problem Statement

Our client has sales data with the purchase timestamp, they need to see the exact amount of sales by every second, minute, hour, day, month, quarter and
year in a visual. So, we used a drill down chart by ZoomCharts in Power Bl to meet the requirement.

Im Power BI

Download the custom visual from marketplace. Drag
the date column to Date axis and Revenue column to - Create Time hierarchy in schema,
values axis. Click on the column bars to drill down the P06, with time attributes like Year,
hierarchy or select units from the top right icon in =T Quarter, Month, Day, hour.
visual. T L ' ' - .

- it Create a report with all the
e attributes which you wish to show
“ %8 - & ey on the dashboard.
Import the report in the dashboard
and create any visualization add any

time based attribute with any
metric. |
rontr Now run the report and right click
.l i on attribute, it will give you option
—— T T : : — to drill onvarious levels you wish.

In Power Bl, datacanberepresentedinthe formofa Column, Line or Area chartin Drill-Down chartfortimebaseddata where
n I C._e as in MSTR we have to create hierarchyand add attributestoreportand then we candrill toonly level which we have created.

ST ETCRST VIt s SOl #PowerBl, #techietalks, #mstr, #MicroStrategy Courtesy- Nikita Dalela, Pooja Darbhe




techie talks™ Color Change using DAX

Problem Statement

Our client wants to see the month wise sales in a line chart. The functionality must be such that data up to a specific month selected on slicer should be
represented by a black line and that after the specified month by a red line.

m Power BI

Create a measure that gives sales | -
for months before selected month | RS SRR (W 1) Crcate o conditional metric
:a_"d anothermrrulge‘:sglrg thai ORI | 5neetsrrontn 1casenectesmontn, Giouay(sneet1, Shestifonth))) whiore chisck i the miohthisraater
sales for month after selected T B e e ot

month. Drag these measures into s
Line chart and set data colors as || WSS
‘black and red respectively. B <. vicnyo=s:

2) Create another conditional metric
Sales by month where check if the monthis less
than selected filter month value

Month Number

= 3) Plot these metrics on chart and
' ‘manually give them different color
for each metric line

In Power Bl, we achieved the requirement by creating two measures in DAX whereasin MSTR we need to createtwo

n I C._e conditional metricsto achieve thistype of scenario.

ST ETCRSTI N[ [s Sl #PowerB, #techietalks, #mstr, #MicroStrategy

Courtesy- Nikita Dalela, Pooja Darbhe




tEChi! t;lkpéd Maps Supported in Power Bl

Problem Statement

Our client wants to explore the maps and their features in Power Bl in order to show ratings of food in different country.

ARCGIS - ESRI Map

"""""

Senegu

1. You can pin locations(till street address) even if it is not
in your dataset.

2. Adding layers to map.
3. Drive time can be calculated( ex. | want to know cafe

near my place within 30 mins of drive time)

n Iee 4. Pre created infographics can also be added.
STIEICRST NIl #PowerBI, #techietalks, #mapbox, #ESRI Courtesy- Neha Rajgadkar, Aasawari Ghate

1. Render Massive location data fast.
2. Ability to display multiple layer in
single map.

3. Highly customizable properties.

1. Analysing and animating
data.

2. Can display images/icons
instead of data.
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